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This paper addresses several frequently asked questions concerning Autodesk’s 
Design Web Format. It was compiled from various sources including internal Autodesk 
servers, emails, and previously published content. Autodesk discussion group 
participants will recognize most of the questions as well as their answers.  
 
This document is quite long. The typical reader will not read this document from start to 
end. The normal use case is to browse the table of contents and select the question or 
questions of interest. For comments, questions, or suggestions regarding this FAQ 
please email scott.sheppard@autodesk.com. 
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Format Related Questions 

DWF Usage 

What is Design Web Format (DWF)? 
Design Web Format™ (DWF™) is an open, secure, file format developed by Autodesk 
specifically for sharing engineering design data. Highly compressed DWF files transmit 
quickly, enabling the communication of rich design data without the overhead 
associated with typical CAD drawings. DWF files also retain the fidelity and rich data of 
the original file. With DWF, users can view and print the drawing, map, or model exactly 
as the designer intended. 
 
DWF files are not a replacement for native CAD formats such as DWG. The sole 
purpose of DWF is to allow designers, engineers, developers, and their colleagues to 
communicate design information and design intent to anyone who needs to view, 
review, or print design information.  
 
More information on DWF, including a DWF White Paper, is available online at 
www.autodesk.com/dwf. 

Is DWF an “open” file format? 
The DWF format is an open file format. It is freely available to everyone – even 
Autodesk competitors. Autodesk publishes the DWF specifications and includes C++ 
source code, libraries, and sample code in the DWF Toolkit for anyone who wants to 
build applications around the DWF format. Furthermore DWF is based on other industry 
standards such as ZIP/ZLIB, XML, JPG/PNG/bitonal-G4-Tiff, and HSF. 
 
More information is available online at the Autodesk DWF Developer Center. 

How much does DWF cost? 
Publishing, viewing, and printing DWF files are free. DWF publishing capabilities are 
integrated into Autodesk® applications. Furthermore, with the free Autodesk® DWF™ 
Writer, anyone can create DWF files from any Windows®-based application by simply 
choosing Autodesk DWF Writer from the standard Printer Name drop-down list. The 
Autodesk DWF Writer enables users of other CAD applications that do not offer built-in 
DWF publishing, such as Bentley® MicroStation® and Solidworks®, to create DWF 
files. Viewing and printing DWF files is free with the lightweight Autodesk DWF Viewer. 
You can also view, print, measure, mark up, track changes, and integrate reviews with 
Autodesk DWF Composer. 

Why is Autodesk investing in DWF? What is Autodesk’s strategy? Why 
free? 
Customers benefit greatly from the ability to use the DWF format. DWF enables greater 
collaboration in the design cycle and provides downstream benefits to users in the 
supply chain. Autodesk is expanding customers’ access to data and helping them get 
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more value out of it. Autodesk is also helping them increase their return on their existing 
investment in CAD applications. 

Who is using DWF? What are they doing with it? 
Autodesk is currently working with many of its partners on software solutions based on 
DWF including: UGS, Microsoft, HP, Océ, Intel, KIP, CADZation, Informative Graphics, 
Adenium Systems, PLP, Bluebeam, and Tailormade Software. Autodesk is actively 
working with these partners in terms of converting, printing, and extending design 
information based on DWF. See Autodesk Technology Partners Adopt DWF to Share 
Rich Design Information Quickly, Easily, and Securely on the Autodesk web site for 
more information. 
 
Autodesk has a wide variety of customers using DWF. This includes industries such as 
Building Information, Manufacturing, and Infrastructure. Some examples include MKM & 
Associates, City of Charlotte and Mecklenburg County, British Airport Authority, Barraco 
and Associates, and Centrex Homes. For more information, see the Customer Stories 
section of the Autodesk web site. 

How does DWF compare to PDF? When should each format be used? 
In a nutshell, the Portable Document Format (PDF) from Adobe is well suited to text-
based documents such as specifications; however, when it comes to design data, DWF 
has some decided advantages. 
 
Looking at DWF versus PDF file formats reveals some commonalities between the two. 
Both formats produce self-contained files, support multiple pages, and provide copy, 
print, and password-protection functions, as well as raster and vector graphic support. 
With the purchase of Adobe® Acrobat® 6 Professional, users can publish files from 
AutoCAD software, preserve CAD layers, and create redlines and comments as they 
can with the DWF format. 
 
However, PDF falls short compared to the DWF format in several key capabilities. 
Although the DWF format was designed specifically for sharing rich design data, PDF, 
or Portable Document Format, was designed for text-based document exchange. Today 
Autodesk provides a better format for distributing and sharing engineering design data 
with DWF files. The DWF format provides  
 

o Accuracy, fidelity, and data richness. DWF is built to support real-world 
coordinate measurement and 3D viewing. DWF files can be produced at a much 
higher precision than PDF, which is required for accurate presentation and 
measurement of engineering designs.  

o Performance and scalability. DWF files are normally much smaller than PDF 
files–often 1/3 to 1/10 the size. DWF files transmit faster, load faster, and can be 
emailed more easily without hitting system limits. The DWF viewing technology 
renders large models faster and enables real-time manipulation of large data sets 
through the use of spatial indexing technology not available with PDF.  
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o Productivity and workflow. The DWF format supports advanced markup, 
measurement, and workflow features not available with PDF. DWF includes 
markup remarks, timestamps, history, and status information and supports 
standard engineering markup symbology to improve communication. DWF 
measurements reflect real-world units rather than paper distances on a viewport-
aware basis without requiring user calibration. The Autodesk DWF Composer 
and AutoCAD applications make full use of DWF intelligence with markup 
browsing and round-trip markup.  

o 3D graphics. DWF 3D capabilities best capture the design intent of engineering 
models, including assembly metadata. View and print 3D DWF files published 
from Autodesk Inventor 9 or the beta versions of 3D publishing for Autodesk 
Architectural Desktop 2005 and Autodesk Building Systems 2005. 

DWF Security 
In this age of digital design information, many participants in the design process have 
asked questions regarding DWF and security. 

Is DWF a secure format? 
Yes, DWF files are secure, helping to protect the integrity of the original design. DWF 
files are similar to paper plots—by default they include only what the designer intends to 
share. Layer information can be turned on or off; object definitions metadata, block 
attributes, and properties are not included unless published by the CAD user. Password 
protection and encryption of the DWF file further ensure the security of DWF files. 

How does DWF compare to the security of paper? 
One of the advantages of a DWF as compared to a source DWG is the security offered 
by DWF. DWF has security similar to physical paper. 
 
When you take a measurement in AutoCAD from a DWG file, you are using a 64-bit 
double-precision floating point value that gives you extreme levels of precision and 
accuracy. You also have a tremendous amount of model intelligence. For example, an 
Architectural Desktop door knows it is a door, and the wall knows that it needs to have a 
hole to contain the door, and that the framing inside the wall needs to adjust based on 
the position of the door. The door and walls are not just pictures made of lines. Instead 
they are intelligent objects with cross-linked relationships. 
 
When you take a measurement using physical paper and a physical ruler, we all know 
there are limitations to the precision and accuracy of what we can measure. For 
example, we all know that with this method you only have an array of inked pixels 
depicting a picture of a wall with a door. The model intelligence has been lost. 
 
The DWF files you generate with default settings are essentially electronic plots 
generated from AutoCAD's (or another application's) plot engine. As such, many of the 
same limitations apply to DWF as to paper. This is where security comes in: Since the 
DWF file does not have the same precision and accuracy, and since the DWF geometry 
is tessellated (blocks and objects get exploded into their individual graphic primitives), it 
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is not easy to turn a DWF file back into a DWG file (just like it isn't easy to turn paper 
into a DWG).  
 
Historically it has always been possible to use paper to painstaking turn a printout back 
into a DWG by tracing over the printout. As with paper, even if you did the work to 
convert the DWF file back into a DWG, you would be missing all of the model 
intelligence. For example, there’s no way to recapture the relationship between the wall 
and its door. Many customers feel that physical-paper is sufficiently secure, and they 
want that same level of security with DWF.  
 
As with paper: 

o By default DWF files do not include layer information. This prevents users 
from turning off layers, printing the results, and then building something 
incorrectly. If desired, the DWF author can change his default so that layer 
information is published to the DWF. 

o By default DWF files do not include object definitions. The smart objects 
from the DWG are turned into tessellated geometry like lines and circles. DWF 
files are similar to the effect of an EXPLODE operation on every object where 
one AutoCAD entity is tessellated into many dissociated DWF vectors. 

o By default DWF files are generated at 400 DPI (dots per inch) so that they 
have the same low precision as physical paper. This is in great contrast to 
DWG which uses very high precision double-float values. Customers can specify 
the DPI value when publishing a DWF if they require higher precision 
measurements. 

o By default DWF files do not include metadata, block attributes, or object 
properties. This data is only added to the file at the discretion of the publisher. 

 
Though some solutions exist, Autodesk does not provide end-user tools for editing DWF 
graphical content. 

What about cryptography, encryption, and password protection? 
For additional security, DWF has digital encryption features such as password 
protection. You can encrypt a DWF and apply a password to the file when you create 
the DWF from a CAD application such as AutoCAD. Although this provides even an 
extra level of protection, this is not foolproof since zip password recovery applications 
are available via the web. Security is always a balance between the costs of keeping 
the data from falling into the wrong hands versus the ease of which it can be delivered 
into the right hands. 

What about other forms of access control, digital rights management, and 
access logging? 
Since DWF is just a digital file, it is compatible with standard enterprise security systems 
such as project hosting services, document management systems, and file server 
access control systems. You can combine these control systems with the built-in DWF 
encryption or use them independently. 
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For DRM (digital rights management), PKI (public/private key infrastructure), or other 
asymmetric encryption features, there are several products on the market which can 
encapsulate a DWF file in an encryption “envelope” that can then be controlled so that 
only specific people have specific revocable rights to the DWF content. 
 
Autodesk is considering adding DRM and PKI features to a future version of DWF and 
the DWF Viewers. 

What about digital signatures? 
DWF does not yet have direct support for digital signatures, though it is planned for a 
future release. Some customers have used 3rd party technologies such as PGP which 
can place any file format (such as DWF) inside an “envelope” file which can then 
digitally signed by the 3rd party product. 
 
As for visible seals, these can be applied in the CAD design application (such as 
AutoCAD) by inserting a graphic picture of a seal that is then printed/published into the 
DWF. There is no security when you do this; it is only a picture like any of the other 
copy-able graphics that get stored in the DWF; however, this is similar to what many city 
governments do when they scan in wet-signed and sealed paper into TIFF and then 
store the TIFF. The scan of the seal in TIFF is nothing but a picture which can easily be 
copied and forged. If the scanned TIFF is acceptable for them, DWF is no different in its 
level of security than the paper. 
 
Note that physical ink signatures are only secure in the physical world. An electronic 
scan of a signature can be forged, but chemical ink on paper cannot be easily forged. 
 
Note that digital signatures are only secure in the digital world. If you print a “seal” 
representing a digital signature to a piece of paper, you can simply Xerox that image or 
capture the image vectors as they go to the printer to forge it. You cannot forge the 
digital signature in its digital non-graphical form. There are many products on the market 
(like PDF) which allow a digital signature to have a graphical representation when 
printed to physical paper. It is important to understand that such printed renditions of 
digital signatures are less secure than an ink signature on paper. Remember: digital 
signatures are only secure when in their digital form. 

Can someone copy geometry from a DWF and paste it into AutoCAD? 
Yes. This is essentially the same operation as performing raster-to-vector from physical 
paper.  A user can also do the same thing with PDF using Adobe Illustrator. There are 
also third party tools that provide this functionality as well for both DWF and PDF. The 
results of these processes are not as-good-as-the-original DWG files. DWF files are 
generated at low resolution and with only a fraction of the data of the original DWG.  
The author of the DWF controls what information goes into the DWF and at what 
resolution. In any system where someone can see the picture, there is always a way to 
copy and/or edit the data. This is true for paper and non-paper formats. If you can see 
something, you can take a picture of it, raster-to-vector it, and copy / edit it. See the 
following section on precision for more information. 
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DWF Precision 
Accuracy reflects the quality of nearness to the truth or a true value. Precision reflects 
the number of significant digits to which a value can be reliably measured. With the 
widespread adoption of Autodesk DWF Composer for digital measurement, designers 
must be wary of options regarding precision when generating DWF files. 

Why aren’t my measurements 100% accurate with DWF? 
By default, Autodesk DWF Writer 2 and AutoCAD 2004 generate DWF files at 400 dots-
per-inch on whatever virtual paper size you plot to. If you plot to an 8.5x11 inch paper, 
that means in the horizontal dimension there are only about 4,000 dots or coordinates 
that the DWF lines can terminate at. This effectively limits the precision of any 
measurement. This is an intentional limitation that contributes to the security of DWF by 
mimicking the precision available with physical paper. 
 
If your drawing represents a 300 foot long building, and if that floor plan (after you 
account for margins) fills about 66% of the width of the page, that means there are only 
4,000 * .66 = 2,640 dots at which the lines terminate. This means that your precision is 
300 feet / 2,640 dots = 0.1136 feet (or 1.36 inches). Wow! So if you use the default 400 
DPI on small 8.5x11 inch paper you can only take measurements that are accurate to 
within about 1 inch! This is much less precise than AutoCAD (which can measure 
features smaller than an atom!). Also note that the DWF in this example is actually 
HIGHER precision than what you would be able to do with a ruler and physical piece of 
paper. 
 
These default settings can be changed so that you can measure with whatever 
precision is desired. 

How do I improve the precision of my DWF measurements? 
The analogy is the same for DWF as it is for paper. With paper, if the author wants 
consumers to be able to make better measurements, you print to larger paper. If you 
design your 300 foot long building and print to big E-sized paper rather than Letter-
sized, the result is better precision both with physical paper and for DWF (since the 
DWF will be using the same 400 DPI times a lot more inches of virtual paper which 
means there are a lot more dots). 

How do I specify higher precision without changing the paper size? 
Changing the paper size may not be an option if you want the DWF to print to scale on 
a particular printer. Your printer may only print to a specific paper size, for example. 
 
With physical paper you do not have many options here. You could get a higher 
resolution printer (1000 DPI rather than 300 DPI for example), but it is still hard to get 
additional precision when using a ruler and the human eye. For the most part, you have 
to go to a bigger paper size to get higher precision measurements with physical paper. 
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With DWF you can leave the paper size alone (for example, 8.5x11) and change the 
DPI setting (in the AutoCAD plot options custom-properties dialog or the Autodesk DWF 
Writer’s advanced settings dialog). You can set this DPI up to a much higher number 
(the DPI times the paper width must be less than 2^31 which is 2,147,483,648). If you 
used the maximum precision of DWF (which is still a lot less than for a DWG which uses 
2^48) you can get great precision in your measurements. For example: for an 8.5x11 
inch piece of paper, we could set the DPI in AutoCAD to be 195,225,786 DPI (try that 
with your laser printer!). In our example if you crank the math out you'll find that you can 
measure your 300 foot building down to 0.000028 inches!! When was the last time you 
needed a measurement accurate to one-10,000th of an inch? 
 
Let’s also consider a GIS mapping example. DWF has a maximum precision of 
2,147,483,648 total dots when you increase either your DWF DPI or your DWF paper 
size (or a combination of both). If we say the continental USA is about 3,000 miles wide 
at what precision can a DWF resolve a map of the USA? Well that’s just (3000 mi * 
5280 ft/mi * 12 in/ft) / 2,147,483,648 = 0.089 inches. In other words when making a 
DWF that represents the entire continental USA we can resolve objects down to a 
precision that is about 2.3 millimeters in size! Not many people need precision that high 
on something so large! However, if you use the default AutoCAD DWF precision of 400 
DPI on an E-sized sheet of paper you’d only be using 14,400 out of the available 
2,147,483,648 DWF dots and thus you’d only be able measure the USA down to +/- 
1,100 feet. As such, understanding the precision requires is key before generating DWF 
files. 

I increased my DPI value very high, but my measurements still aren’t 
perfect. Why? 
The paper size and the DPI setting are only part of the story. That determines the 
absolute maximum possible precision that is available. However, other factors influence 
the precision of your measurements. For example, when you measure between two line 
endpoints, where exactly are you measuring between? Remember that lines have width 
and they have end-caps. As such they have volume. Since some types of geometry 
become tessellated in the DWF file (by the authoring application, not by DWF itself) and 
many types have volume, the auto-snap technology sometimes cannot tell exactly what 
piece of tessellated geometry or which part of the volume you are wanting to measure 
from. For the line case, are you measuring from the line endpoint or from the edge of 
the line-cap semi-circle that extends past the endpoint? Also, the auto-snap technology 
in certain cases may depend on the resolution of your screen (for very dense drawings 
the mouse can only point at a particular screen pixel; and there are very few pixels on a 
screen). Furthermore, the DWF coordinates have to pass through multiple coordinate 
transforms. Each transform introduces round-off errors and precision errors which may 
accumulate. For most drawings (plotted at sufficient DPI to a sufficiently large paper 
size) these issues are so extremely small that you can ignore their effect. 
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If my drawing measures fine, why does it still look imprecise after 
increasing the DPI? 
What’s happening is what would happen with physical paper. Normally printed lines 
have a line weight (based on the concept of a “pen width” from the pen plotter days). If 
you take a very dense and complicated drawing and plot it onto a very small piece of 
paper (something the size of a postage stamp) using a thick pen (like a magic marker) 
you’d end up with “mud.” To fix this you need to do one of two things: either use a pen 
setting with a more narrow weight (or even a pen with an infinitely thin zero-weight), or 
you need to plot to much bigger (virtual) paper. 

In summary, how can I get better precision? 
To get better measurement precision: 

o The DWF author must intentionally publish the DWF at high enough resolution 
for accurate measurement. By default the precision is nearly that of physical 
paper as part of the security concept.  

o The DWF author can increase the size of the virtual DWF paper.  
o The DWF author can increase the DPI setting of the DWF driver to use more 

pixels and precision. Increasing DPI will increase the DWF file size, so you do 
not want to use an unreasonably large DPI. Doubling the DPI will only have a 
slight effect on file size, but will double the precision. DPI values above 5,000 are 
rarely required, but you may use any value up to a maximum of 2,147,483,648 
divided by the longest dimension of your paper in inches. 

o Plotting without line weights may make DWF files more visually precise. 
 
With these tips in mind, users can avoid any problems related to precision. For 
example, DWF can measure the continental USA with a precision of +/- 2.4 millimeters 
when using the maximum DPI and paper size settings. 

Can I convert my DWF to DWG? 
There is a free DWF to DWG converter located at http://www.intelcad.com/pages/dwfin/ 
which has a 14 day trial. Caution: A DWG uses floating point doubles. A DWF uses 32 
bit integers. You will lose precision and to that extent - accuracy. Converting a DWF to a 
DWG is the equivalent of scanning in a plot and tracing over it. 
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Application User Questions 

DWF Generation 

What Autodesk software publishes DWF files? 
You can publish DWF 6 files from several Autodesk applications, including the following: 
 

o AutoCAD® 2006, 2005, 2004, and 2002  
o AutoCAD LT® 2005, 2004, and 2002  
o AutoCAD® Mechanical 2005, 2004, and 6  
o Autodesk® Architectural Desktop 2005, 2004, and 2002  
o Autodesk® Building Systems 2005, 2004, and 3  
o Autodesk Inventor® 8 and 7  
o Autodesk Inventor® Series  
o Autodesk® Land Desktop 2005, 2004, and 3  
o Autodesk Map® 2005, 2004, 6, and 5  
o Autodesk® Revit® 6, and 5 with the Autodesk DWF Writer  
o Autodesk® DWG Viewer bundled with Autodesk DWF Composer  
o Volo® View 3 (batch-publish DWF files) 

 
Note: Publishing DWF files from AutoCAD 2002 or any AutoCAD 2002–based product 
is available to subscription members with the installation of the Design Publishing 
Extension. Earlier versions of the software can publish DWF 5. 
 
You can also create DWF files using the free Autodesk DWF Writer. Use the Autodesk 
DWF Writer to securely and efficiently distribute designs or other documents in Design 
Web Format™ from any application. Autodesk DWF Writer software is a certified 
Microsoft® Windows® system printer driver that gives you the capability to publish DWF 
files by simply choosing Autodesk DWF Writer from your standard Printer Name drop-
down menu. 

How do I convert a DWG or other file type to DWF format? 
The ability to publish DWF files is built into Autodesk design applications, including 
AutoCAD® 2000 and later. Tips on how to publish DWF files from Autodesk applications 
are available in the DWF Center under “Publishing.”  
 
If you are using an earlier version of Autodesk design applications or another vendor’s 
software, like Bentley MicroStation®, Pro/E®, or SolidWorks®, you can use the free, 
downloadable Autodesk DWF Writer available at www.autodesk.com/dwfwriter. The 
Autodesk DWF Writer is a Windows printer driver that enables creation of DWF files 
from any application. 
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What is the Autodesk DWF Writer? 
The Autodesk® DWF™ Writer is a certified Microsoft® Windows® system printer driver, 
so you can publish DWF files by simply selecting Autodesk DWF Writer from your 
standard Printer Name drop-down list in any Windows application.  
 
The Autodesk DWF Writer is extensively tested with Autodesk® Revit® to ensure full 
fidelity of Revit data. The Autodesk DWF Writer also works with other CAD applications 
that do not offer built-in DWF publishing, such as Bentley® MicroStation® and 
SolidWorks®.  
 
Autodesk DWF Writer requires one of the following operating systems: Microsoft 
Windows Server™ 2003, Windows XP Professional or Home Edition, or Windows 2000. 

How do I create 3D DWF files? 
You can publish 3D DWF files from Autodesk Inventor 9 software and from Autodesk 
Architectural Desktop 2005 and Autodesk Building Systems, available to subscription 
members. Instructions on how to publish 3D DWF files from these applications are 
available at www.autodesk.com/dwf-publishing. 

What is the difference between native file formats like DWG and IPT and 
DWF? 
Publishing native design files such as DWG and IPT formats created with design 
authoring software can be impractical for a variety of reasons. Protecting intellectual 
property is a primary concern because anyone with the AutoCAD, Autodesk Inventor, or 
another design authoring application can edit the file or steal the design. Moreover, the 
cost of the authoring software may exceed the need of the user. Paying for everyone on 
the team to install and then learn to use a sophisticated CAD or mapping application 
can be costly. Using the DWF format avoids these issues. 
 
DWF is a secure file format that is smaller, more compact, and easier to distribute than 
DWG or IPT files yet still maintains the rich design data of the original design. CAD 
users can publish drawings, maps, or models to the DWF format so reviewers see 
exactly what the publisher intended them to see. In addition, the DWF file format 
supports multisheet drawing sets and makes it easier for team members who don’t use 
CAD to view and print. 

How can I create DWF files that are compatible with the old WHIP! viewer? 
As the name suggests, an old DWF files is referred as to a “classic DWF.” The old 
“DWF Classic.pc3” works fine with new versions of AutoCAD. The pc3 for classic DWF 
files is not installed by default. The proper way to install it is to go through the "Add-A-
Plotter" wizard and select the appropriate DWF type (DWF Classic) and create a new 
pc3. 
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DWF Viewing 

What is the Autodesk® DWF™ Viewer? 
Autodesk® DWF™ Viewer is a lightweight, free application for sharing designs 
electronically with all members of the project team. Built around the DWF™ file format, 
the viewer enables users to view and print complex 2D and 3D drawings, maps, and 
models published by any Autodesk® design application or by any Microsoft® 
Windows®-based design application using the free Autodesk® DWF™ Writer.  
 
All kinds of people need to see design information during the project lifecycle, and not 
everyone has the software that created it. But that doesn’t matter when you use DWF–
the file format developed specifically for sharing data-rich design information. Small, 
fast, and secure, DWF preserves the fidelity and integrity of designs and allows anyone 
to access the complex design data without the originating design application. DWF files 
are easy to create and post to the web, and they support up to 60 million dpi – the 
precision required for complex design data. 
 
Autodesk DWF Viewer is available as a stand-alone application or as a Microsoft® 
ActiveX® control embedded in Microsoft Internet Explorer. Because the interface is 
easy to use, even novice users can master viewing and printing of design data. The 
ActiveX control also enables users to embed DWF files in other Microsoft Office 
applications like Word, Excel, or PowerPoint®. 

What are the benefits of using Autodesk DWF Viewer? 
The DWF file format and Autodesk DWF Viewer are great ways to: 

o Share designs with members of your project/product team who don’t have 
access to the original design software.  

o Securely share designs in a published format with contractors, clients, or other 
third parties for viewing and printing. 

o Save shipping time and costs by sending CAD files electronically.  
o Present drawings, maps, and models online or in a PowerPoint presentation or 

an electronic catalog. 
o Archive designs to save valuable storage space. DWF files are compact—often 

1/20th the size of DWG files and 1/10th the size of PDF files—yet maintain the 
visual and printing fidelity of the original file. 

Does the release of AutoCAD 2006 mean everyone needs a new Autodesk 
DWF Viewer? 
No. The DWF files generated by AutoCAD 2006 can be read by the Autodesk DWF 
Viewer that is available today. 

Is Autodesk DWF Viewer only for CAD users? 
No. Autodesk DWF Viewer is for anyone who needs to view, review, and print DWF 
files, specifically non-CAD professionals. Autodesk DWF Viewer and the DWF format 
provide a fast, easy, cost-effective solution for communicating design information at any 
point in the project lifecycle. 
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What's new with the upcoming release (Autodesk DWF Viewer 6)? 
Release 6 of the Autodesk DWF Viewer features: 

o Print preview for each sheet or sheet set 
o Streamlined navigator palettes, menus, and toolbars 
o Markup status color coding on markup callouts and custom symbols 

What are the system requirements for Autodesk DWF Viewer? 
o Intel® Pentium®–based PC, 200 MHz or higher  
o Microsoft® Windows® XP Professional or Home Edition, Windows 2000 (SP2 or 

higher), Windows 98 SE, Windows Me, or Windows NT® 4.0 (SP6 or higher)  
o 32 MB RAM minimum (96 MB recommended)  
o 800x600 VGA display or better  
o Microsoft Internet Explorer 5.01 or higher (IE 5.5 required for Windows NT and 

Windows 2000, and recommended for all users) 

Will the Autodesk DWF Viewer run on Windows 98? 
The Autodesk DWF Viewer will run on Windows 98 SE. An always up-to-date list of 
system requirements can be found on the Autodesk web site. The Windows 98 question 
comes up frequently, because Autodesk DWF Composer does not support Windows 98 
regardless of edition. 

Can I view DWF files on my PocketPC? 
The Autodesk DWF Viewer does not run on the PocketPC; however, there are third 
party companies (e.g. Pocket Zing!, PocketCAD DWFView, PowerCAD CE, Dr. DWG 
MOBIlite, VISIARC) who market DWF viewers for the PocketPC. 

How do I use Autodesk DWF Viewer? 
The Autodesk DWF Viewer displays any DWF file either in the web browser or the 
stand-alone application. The main toolbar contains the primary view, orbit, pan, and 
zoom functions. (Tip: The mouse wheel can be used to zoom and pan.) Navigate 
through multisheet drawings using the list and thumbnail views or with embedded 
hyperlinks, or browse a 3D assembly structure. The print function, available from the 
main toolbar or the File menu, has several flexible options. Consult the application’s 
Help menu if you have questions about using the Autodesk DWF Viewer. 

How do I view DWG files in Autodesk DWF Viewer? 
Autodesk DWF Viewer supports viewing DWG files published to DWF format, a more 
compact, secure file format for sharing drawings, maps, and models. DWF files, which 
can be 1/20th the size of DWG files and provide a secure format to protect your 
intellectual property, retain the intelligent design data of the original. Publishing DWF 
files is free, since the capability is built into Autodesk design applications or available 
with the free Autodesk DWF Writer. Learn more about publishing DWF files in the DWF 
Center at www.autodesk.com/dwf under “Publishing.” 
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To view native DWG files, purchase Autodesk® DWF™ Composer, which has a DWG 
Viewer component plus advanced markup, measure, and annotation tools, including 
markup integration with AutoCAD® 2005 and 2006.  

Can I give Autodesk DWF Viewer to others? 
Yes. You can redistribute Autodesk DWF Viewer to anyone without prior approval from 
Autodesk, subject to the terms of the license agreement.  
 
The easiest way to share Autodesk DWF Viewer is to include a short message and the 
URL when you send a DWF file. Here is an example:       
 

To read this file, you need the free Autodesk DWF Viewer available at 
www.autodesk.com/dwfviewer-download.  

 
You may also install and distribute Autodesk DWF Viewer to a larger group of users. 
Autodesk encourages electronic distribution of Autodesk DWF Viewer in its intact form. 
The viewer is available free to end users, including developers creating end-user 
applications. Any customization of Autodesk DWF Viewer must be done using the APIs 
provided by Autodesk. 

Can the Autodesk DWF Viewer be installed silently? 
You can do this by way of command line scripting. For the full details on all of the 
command line install options, see: 
 
http://www.tarma.com/support/index.htm#/support/cmdline.htm  
 
This documentation link is based on the Tarma install technology we use for our viewer 
installers. 
 
In short there are a couple of silent install options to suit most user needs: 
 
DwfViewerSetup.exe /q 
 
This performs a silent (quiet, unattended) installation. During silent installations, the 
normal Setup wizard is suppressed and the entire installation, registration, or 
uninstallation process is performed without user intervention. This feature is intended for 
unattended installations and removals. 
 
Or 
 
DwfViewerSetup.exe /q2  
 
This performs an invisible install. In this mode, the entire installation, registration, or 
uninstallation process is performed without user intervention and with a completely 
hidden user interface. (The Setup process will still appear in the Windows Task 
Manager's list of running processes, though.) 
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Note - In silent installation mode you cannot specify user registration information for use 
on the Setup - Registration Information page. Only default user registration, if you 
specified any on the Advanced project page, takes place in silent installation mode. 

How do I check to see which version of the Autodesk DWF Viewer I have? 
You should always use the most current version of Autodesk DWF Viewer. Autodesk 
DWF Viewer 5 is the current release. It supports viewing of 3D models published from 
Autodesk Inventor 9 and from the beta releases of the 3D publishing feature for 
Autodesk Architectural Desktop 2005 and Autodesk Building Systems. Autodesk DWF 
Viewer is backward compatible and reads older DWF files, so you don’t need to convert 
DWF files when you upgrade to a later version.  
 
Note: If you are a Windows 98 or Windows Me user, Autodesk recommends using 
Autodesk DWF Viewer 4.1. You will be redirected to version 4.1 at the time of 
download. 
 
To check for newer versions of Autodesk DWF Viewer as they become available on the 
Autodesk website: 
 

Choose Help>Check for Viewer Updates (Note: You need an Internet connection to 
use this feature.) 
 

You are informed if you have the latest version of Autodesk DWF Viewer, or you are 
asked to install the latest version if an update is available. The actual version number of 
the viewer is displayed in the Help>About dialog. 

How is Autodesk DWF Viewer different from the other Autodesk viewer 
products? 
Autodesk DWF Viewer is a free application for viewing and printing 2D and 3D 
drawings, maps, and models published in DWF files. Additional functionality like DWG 
viewing, measuring, marking up, and annotating, along with round-trip markup, is 
available with Autodesk DWF Composer.  
 
Viewing multiple file formats such as native Autodesk Inventor and DXF files is available 
with Volo View. The Volo View product is reaching the end of its life. Users are 
upgrading to Autodesk DWF Composer. 

When viewing a DWF file on a web site, how do I save a local copy? 
Use Autodesk DWF Viewer 5 to save a local copy of a DWF file published to a website. 
While you are viewing the DWF file embedded on a web page (in Microsoft Internet 
Explorer): 
 

1. Right-click the DWF file and choose Save As. Alternatively, choose the Save As 
button from the toolbar. (Note: The Save As options appear only when you are 
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using Autodesk DWF Viewer in embedded mode—for example, within a web 
page.)  

2. To save a local copy of the DWF file you are viewing, specify a file name. 

How do I navigate URLs using a single click in the Autodesk DWF Viewer? 
With the Autodesk DWF Viewer, you can set the hyperlink activation to be a single-click 
instead of Ctrl-click: 
 

1. Choose Tools>Options.  
2. In the Hyperlinks section, select the Single Click to Follow check box. 

 
To provide this capability for users who view your DWF files, you can use the following 
param tag to do this programmatically on your website: 

<param name="SingleClickHyperlink" value="True"> 
 
Similarly, to control this option via a URL to open a DWF file, specify the following: 

http://filename.dwf?SingleClickHyperlink=True 
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DWF Markup 

Can I use Autodesk DWF Viewer to redline DWF files? 
Autodesk DWF Viewer does not provide the functionality for measuring or redlining 
DWF files. If you or others in your design review team have a measuring or redlining 
requirement, Autodesk DWF Composer is the product for you.  
 

 
 
After installing Autodesk DWF Viewer 5, view, navigate, and print 3D DWF files in the 
Autodesk DWF Composer environment. Markup and measure of 3D DWF files are not 
yet supported. 

What is Autodesk DWF Composer? 
Autodesk DWF Composer software is the only all-digital way to review, mark up, and 
revise designs without the original design creation software. Members of the design-
review team can easily view and print AutoCAD DWG and DWF files with accuracy and 
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fidelity. Use measurement, redlining and annotation tools, complete sheet set 
organization, and powerful status tracking capabilities to communicate changes 
electronically. Then “round-trip” the DWF file, overlaying digital markups onto the 
original CAD file to streamline the review and editing process. Learn more about 
Autodesk DWF Composer. 

Where can I see an overview of Autodesk DWF Composer? 
http://www.avat.com/training/elearning/media/edemos/dwf/media.asx

What are the system requirements for Autodesk DWF Composer? 
When you purchase Autodesk DWF Composer you receive three software components:  

o Autodesk DWF Composer, to review, mark up, and revise DWF files  
o Autodesk DWG Viewer, to view, plot, and publish DWG files  
o Autodesk DWF Writer, to publish DWF files from any application 

 
You install each of these components to access the full functionality of Autodesk DWF 
Composer. There are different system requirements for each of these components. 
 
Autodesk DWF Composer 

o Intel® Pentium® processor or later, 200 MHz or higher, or compatible  
o Microsoft® Windows® XP Professional or Home Edition, Windows 2000, or 

Windows NT®  
o 64 MB RAM minimum (128 MB recommended)  
o 32 MB free disk space for installation  
o 800x600 screen resolution minimum (1024x768 recommended)  
o Mouse, trackball, or compatible pointing device  
o Microsoft Internet Explorer 5.5 or later  
o CD-ROM drive 

 
Autodesk DWG Viewer 

o Intel Pentium III processor or later, 800 MHz  
o Microsoft Windows XP Professional or Home Edition, or Windows 2000 

Professional  
o 256 MB RAM (recommended)  
o 300 MB free disk space for installation  
o 1024x768 VGA with true color (minimum)  
o Mouse, trackball, or compatible pointing device  
o Microsoft Internet Explorer 6.0  
o CD-ROM drive 

 
Autodesk DWF Writer 

o Microsoft Windows 2003 Server, Windows XP Professional or Home Edition, or 
Windows 2000 
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Can I try Autodesk DWF Composer before buying it? 
Yes. There is a 30 day trial version of Autodesk DWF Composer. You can register on 
the Autodesk web site and download a copy. The purchased version of Autodesk DWF 
Composer includes a DWG Viewer. The Autodesk DWG Viewer is too large to be 
downloaded from the Autodesk web site, so it is not included in the trial. But other than 
that, the trial copy is a fully functioning, time limited copy that works with DWF files. 

What are some tips for using Autodesk DWF Composer? 
1. You can drag and drop or use File>Open to view and markup many different 

types of image files like JPEGs, GIFs, etc.  
2. You can drag and drop a DWF or an image into an existing DWF to combine 

items together in a single DWF. Just open the Content Browser on the left 
column of the program, then drop the DWF or image into it. Dropping individual 
or multiple pages from another Composer session works too.  

3. You can drag and drop a page or pages into an email or onto your desktop to 
create a new DWF file.  

4. If you're marking up or measuring on a DWF, do yourself a favor and do so with 
"Tools>Snap to Geometry" toggled on. Now the tools will snap to endpoints, 
midpoints, lines, etc.  

5. Try holding down the Shift key sometime when creating markups or using the 
measure tools. Hitting shift will often constrain movements to commonly-used 
angles, flip vertical dimension labels to the other side, etc.  

6. The mouse wheel button is very handy. Scrolling it will zoom in and out. Holding 
it down and moving the mouse around will pan. This works even when other tools 
are running.  

7. When you make a markup, the current view of the page is stored with that 
markup. Then when you select it in the Markup Browser, you are returned to that 
view. If you want to change the view stored with the markup, pan and zoom to 
the desired view then move the markup slightly or modify it in some way. The 
new view will be stored with it automatically.  

8. You can rename sheets from the Content Browser. Just select the sheet, then 
click on the name once, and edit the name.  

9. Clicking on the current tab in the Navigator will minimize the navigator, giving you 
more screen space. Just click on a tab to make the Navigator visible again.  

10. Try the Options sometime on the Content Browser. You can show thumbnails of 
the original DWF data. 

Autodesk DWF Composer comes with a DWG Viewer. What is it for? 
The Autodesk DWG Viewer allows you to view and print DWG files. It is typically used 
to generate a DWF from a DWG. The capabilities of Autodesk DWF Composer (i.e. 
markup and measure) and then available for the corresponding DWF.  

With only Autodesk DWF Composer, how can I convert my entire set of 
legacy DWGs to DWF? 
To convert all of your DWGs to DWFs, use the Publish command from the Autodesk 
DWG Viewer. 
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Can I markup and measure using the Autodesk DWG Viewer included with 
Autodesk DWF Composer? 
No. You cannot markup or measure using the native DWG. You need to generate a 
DWF from the DWG. This strategy was attempted for the Volo View product. By 
allowing the markup and measurement of native files, Volo View grew larger and more 
complicated than the authoring applications. Although this is sometimes viewed as “an 
extra step,” the process is very similar to what is done for other formats, such as 
generating a PDF file to capture text from a Microsoft Word document. 

Will the DWG Viewer included with Autodesk DWF Composer read 
AutoCAD 2006 DWG files? 
Yes. The DWG format did not change between AutoCAD 2005 and AutoCAD 2006, so 
DWG files saved by AutoCAD 2006 can still be read by the DWG Viewer that ships with 
Autodesk DWF Composer today. 

Does the Autodesk DWG Viewer support “object enablers”? 
Yes. An Object Enabler is a freeware application that allows custom object data created 
in special versions of AutoCAD (e.g. Architectural Desktop, Mechanical Desktop) to be 
accessed outside the AutoCAD environment. The Autodesk DWG Viewer comes with 
object enablers for Autodesk Architectural Desktop. Other object enablers can be 
downloaded from the object enablers download page of the Autodesk web site. 

Can I view Architectural Desktop DWGs with the Autodesk DWG Viewer? 
Can I view other DWGs with custom objects? 
Yes. You can view Architectural Desktop DWG files and other DWG files with custom 
objects. The Architectural Desktop object enablers install with Autodesk DWG Viewer, 
and you can get others from the object enablers download page of the Autodesk web 
site. This page allows you to select a product used to create a DWG, specify that you 
are using the Autodesk DWG Viewer, and it will direct you to the proper object enabler. 

Is the Autodesk DWG Viewer an ActiveX Control? Can I embed a DWG in an 
HTML page and view it using the Autodesk DWG Viewer? 
The Autodesk DWG Viewer that is shipped as part of the Autodesk DWF Composer is 
not supported for automation. This viewer does not expose any API and cannot be 
embedded as an ActiveX control. It can be used only as an application with user 
interaction to publish DWG files to DWF files. There are no plans to change this. The 
Autodesk DWF Viewer and Autodesk DWF Composer are ActiveX Controls. DWF files 
can be embedded in HTML pages or other documents. 

Does Autodesk DWF Composer allow for perpendicular snap? 
Although Autodesk recognizes the usefulness of such a feature, the current version of 
Autodesk DWF Composer does not offer this functionality. This item is on the wish list. 
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Where can I find the API documentation for Autodesk DWF Composer? 
The API documentation for the Autodesk DWF Composer can be found at 
http://www.autodesk.com/developdwfcomposer . At this time, the API is identical to the 
API for the Autodesk DWF Viewer. Hence it is not possible to add markups and take 
measurements using automation. Additions to the API for Autodesk DWF Composer will 
be included in a future release. 

Can Autodesk DWF Composer be run on a Citrix or Terminal Server? 
No. This is a violation of the license agreement, regardless of the number of copies 
purchased. The price of Autodesk DWF Composer has been set with the intention that 
each user will install one copy on one machine. 

DWF Printing 

Can I send DWF files to a commercial reprographer for printing? 
Yes and No. If you use a reprographer who has: 

1. Océ Repro Desk, then you have two choices. One avenue is to download the 
Océ Client Tools and batch process your DWF files into LDF files. The LDF files 
can then be sent to the reprographer. Alternatively, your reprographer may be 
using Repro Desk Server 1.6.3 which can be configured to accept DWF files and 
automatically convert them to LDF. For these reprographers, you can send them 
DWF files directly. Additional details regarding available options with Océ 
hardware can be found in the Océ white paper Integrating DWF Printing into your 
Océ Repro Desk workflow. 

2. PLP Plotworks, then you should check with your reprographer to see that he 
has obtained the PlotWorks DWF to Tiff module. This module is available at no 
cost to reprographers who have a maintenance contract with PLP. For these 
reprographers, you can send them your DWF files for printing. 

In cases where neither of these possibilities exists, you will need to use the Autodesk 
DWF Viewer to print your DWF files to another format, e.g. HPGL, and send the 
resulting files to the reprographer. 

What is the status of printing DWF files by commercial reprographers? 
Reprographers using Océ Repro Desk Server 1.6.3 can configure Repro Desk Server to 
automatically convert DWF files to LDF for printing on Océ devices. Océ is working to 
provide direct DWF support in Océ Repro Desk 2.0 as well as its PRISMA corporate 
server solution line. PLP PlotWorks 5.5.1 supports DWF files directly today. Autodesk 
continues to work with other vendors such as Adenium and KIP on integrating DWF 
support into their commercial printing offerings. 
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DWF Troubleshooting 

When I try to publish a drawing, I receive this error: "ERROR: Layer not 
initialized," and the drawing will not publish. Why? 
A DWF is like an electronic plot. It takes the settings from your layouts, as intended for a 
piece of paper, and captures all of that in the DWF file. An unitialized layer means that 
you need to make sure your layouts have been mapped to a specific plotter. I know you 
may never have any intention of plotting from AutoCAD, using DWF exclusively instead, 
but the DWF file will be constructed so that it looks like what the layout would have 
looked like if it had been plotted to the device. So please ensure that all layouts have 
complete and desirable plotter settings before creating your DWF files. 

I published one of my drawings and the text was illegible or the font was 
wrong. What might be happening? 
This normally comes down to one of 4 issues: 

1) The user is using an out of date viewer. There was an issue with certain fonts in 
an old release. Make sure the user has Autodesk Express Viewer 4.x or 
Autodesk DWF Viewer 5.1 (the viewer has been renamed, but it is the same 
program) or higher. You can get the current download from 
www.autodesk.com/dwf 

2) The DWF was plotted to a virtual sheet of paper that was too small compared to 
the pen weight used. This is more of an issue for stroked fonts rather than 
TrueType fonts. This is the same issue that would happen if you printed a really 
complex drawing onto a small piece of paper like 8.5x11 inches: you’d get mud. 
You have to print big drawings onto big paper, or in the case of DWF, onto big 
virtual paper. Change the page size of your layout and try again. 

3) The author of the DWF chose not to embed a font into the DWF which the 
printing machine doesn’t have. If you edit the “ePlot DWF 6.PC3” settings and 
look under “Custom Properties” you’ll see three settings for DWF font 
embedding: 
a. Embed none. This can make your files smaller, but people might not be able 

to get an accurate printout because they might be missing a needed font. In 
this case the viewer substitutes a font in place of the missing one, but the 
substituted font may not be desirable or accurate. This is not the default 
setting. 

b. Embed Some: This is the default setting. In this case AutoCAD embeds the 
fonts being used into the DWF, with the exception of certain specific fonts. 
The specific fonts that are excluded from embedding are ones that are very 
common and widespread because they are shipped with most versions of 
Microsoft Windows. This is the default because it has a good balance 
between file size (since we do not embed common fonts like “Arial”), but we 
do embed all other fonts that the printing machine might not have. We have 
found cases where some machines are missing some of the “standard” 
Windows fonts which AutoCAD doesn’t embed. This might be your problem. 
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c. Embed All: This setting will make larger files, but will embed every font being 
used (including “standard” fonts) into the DWF so that the printing machine is 
guaranteed to have all the data that is needed. 

4) The printer driver (from your printer manufacturer) has a bug. Some printer 
drivers have a setting for “use vectors” vs. “use rasters”: changing this setting 
may avoid the driver bug by using a different approach. Alternatively you should 
check with your printer manufacturer for an updated driver. 

I have a DWF file with lots of text. Why does it open so slowly in older 
viewers? 
This is a known issue with DWF drawings that have lots of True Type Text when using 
an older version of the Autodesk DWF Viewer. Microsoft changed the default setting for 
anti-aliased fonts in Windows XP. It used to be off and is now on by default as long as 
the color depth of the display adapter is high enough. Anti-aliasing of fonts makes them 
look nicer when displayed but it dramatically slows the loading and rendering of text. 
  
The work-around for Autodesk Express Viewer 4.1 (ADV) or earlier is to turn off anti-
aliased fonts in Windows. Autodesk DWF Composer and Autodesk DWF Viewer 5.0 or 
higher have a permanent fix so that users won’t need to change their anti-alias settings. 
The products will turn off anti-aliased fonts at load time and turn it back on for 
subsequent rendering. 
  
Here’s how you implement the work-around if you choose not to upgrade to Autodesk 
DWF Viewer 5.0 or higher: 

1) Right click on “My Computer” and select Properties 
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2) Select the “Advanced” tab and then “Performance > Settings”: 

 

www.autodesk.com/dwf 26 



3) In the dialog choose “Custom” and then de-select (turn-off) “Smooth edges of 
screen fonts” 

 
4) Click OK and then OK 

  
Now try your drawing again and you should see a dramatic performance increase. 

Windows® XP SP2 security alert displays when viewing DWF files 
embedded in web pages. How do I fix this? 
In Windows® XP SP2, the following security alert is displayed each time you view an 
embedded DWF™ file using Autodesk® DWF™ Viewer or Autodesk® DWF™ 
Composer:  
 

To help protect your security, Internet Explorer has restricted this file from 
showing active content that could access your computer. Click here for options. 

 
For English, Japanese, and German versions of Autodesk DWF Viewer 5, please 
download and install the latest build (521).  
 
For earlier versions of the Autodesk DWF Viewer, please upgrade your viewer to 
Autodesk DWF Viewer 5 build 521. 
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Note: With this new version of Autodesk DWF Viewer 5, the Windows XP SP2 security 
alert will continue to appear when viewing DWFs embedded in local HTML pages. You 
can suppress this message by adding the following HTML tag as the first line of any 
local HTML page that hosts DWF files: 
 

<!-- saved from url=(0014)about:internet --> 

How do I eliminate graphic artifacts when using hardware acceleration from 
my graphics card to view 3D DWF files? 
Certain graphics cards can cause viewing conflicts or display artifacts when hardware 
acceleration is enabled. If you see unexpected graphics artifacts in a 3D DWF file, turn 
off hardware acceleration as follows: 
 

Choose Tools>Options.  
Uncheck the Enable Hardware Acceleration setting. 
 

If Autodesk DWF Viewer crashes or hangs when attempting to open and view 3D DWF 
files, turn off hardware acceleration using the following registry setting. (Note: If the 
registry entry does not exist, you can create it.) 
 

[HKEY_CURRENT_USER\Software\Autodesk\DWF Common\Preferences\User 
Interface] 
"Use Hardware Acceleration"=dword:00000000" 

 
Note: There are known conflicts with certain types of Matrox graphics cards. 

I am getting a warning when I view a 3D DWF file created with the Autodesk 
Inventor 9 Beta version. How do I eliminate this warning? 
If you open a 3D DWF file and see the following error message: 

"Your current viewer does not support this file version. You need to upgrade the 
viewer to view this file. (700)" 

 
You are either: 
 

1. Viewing a DWF file created with a beta version of Autodesk Inventor that needs 
to be republished in Autodesk Inventor 9.  

2. Viewing an invalid Autodesk Inventor 3D DWF sample from the Autodesk 
Inventor CD. Newer versions of these samples are now available for download at 
www.autodesk.com/dwf-samples 

 
The Autodesk Inventor Beta produced DWF version 7 files, which subsequently 
reverted to version 6. The shipping version of Autodesk Inventor 9 publishes DWF 6.01 
files, which can be opened and viewed with Autodesk DWF Viewer 5. 
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Why is my DWF file bigger than my DWG? 
There are a few possibilities. A small parent DWG may XREF other DWG files. On the 
other hand, a DWF contains everything in one file. So when a DWF is compared solely 
to its parent DWG, perhaps the DWF is larger. In addition, a DWG may reference an 
external image file. In this case, a copy of the image file would be in the DWF. As 
mentioned, the DWF file is one stop shopping in that the DWF has everything a person 
who wants to view it would need. There are even cases where font files can be 
embedded in a DWF. Also of note is that some specialized objects such as AutoCAD 
gradients are finely tessellated into simpler (though more numerous) geometry when the 
DWF is created. 
 
A DWF file is compressed. Under normal circumstances it is smaller than its 
corresponding DWG. It is almost certainly smaller than the collection of files associated 
with a DWG if not the DWG itself. 
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Application Program Interface (API) User Questions 

DWF Embedding 

How do I embed a DWF file in an HTML page? 
You can embed DWF files directly in your web pages by using the <object> element 
tag. Using the free copy of Autodesk DWF Viewer, you can also ensure that users 
viewing your web pages have quick access to view the DWF file even if they don't 
already have a viewing application available. Note that Microsoft Internet Explorer 5.01 
or later is required. 
 
The following HTML snippet demonstrates how to embed a DWF file in your HTML 
documents. You can copy/paste the following sample HTML. 
 
HTML sample 
 
<OBJECT CLASSID="clsid:A662DA7E-CCB7-4743-B71A-D817F6D575DF" 
 CODEBASE=http://www.autodesk.com/global/dwfviewer/installer/DwfViewer
Setup.cab#version=5,1,0,527 
 WIDTH="640" HEIGHT="480">  
<PARAM NAME="Src" 
 VALUE="http://www.autodesk.com/global/dwf/samples/bracket.dwf"> 
</OBJECT> 
 
How it works 
 
The CLASSID attribute value specifies Autodesk DWF Viewer as an ActiveX® control in 
place of the <object> tag when viewed within Internet Explorer: 

<OBJECT CLASSID="clsid:A662DA7E-CCB7-4743-B71A-D817F6D575DF" 
 
The CODEBASE attribute value is the path to the Cab install file.  

CODEBASE="http://www.autodesk.com/global/dwfviewer/installer/DwfViewerSet
up.cab#version=5,1,0,527"> 

You can specify relative or full paths. This value can also be used to ensure the proper 
version of Autodesk DWF Viewer is available on the user's machine. If a user viewing 
your web pages does not have Autodesk DWF Viewer or the version specified, the user 
is automatically prompted to download and install. 
 
To specify the DWF file to display, you need to use the <PARAM> tag with the following 
attributes. The Src parameter is used to specify the path to the DWF file you would like 
to display: 

<PARAM NAME="Src" 
VALUE="http://www.autodesk.com/global/dwf/samples/bracket.dwf"> 

The VALUE can be a full or relative path. 
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How do I embed a DWF file in a Microsoft Office document? 
Note: Microsoft Word is used for the examples below. Embedding DWF files within 
other Microsoft Office applications may vary slightly. This feature is supported for 
Microsoft Office 2000 and later.  
 

1. From the application main menu select “Insert > Object.” From the “Object” 
dialog, under “Object Type” select “Autodesk DWF Viewer Control” from the list 
of options. Click “OK.”  

2. Autodesk DWF Viewer appears on the page at the insertion point as an ActiveX 
control. You can resize the control to fit your needs.  

3. Click on the Autodesk DWF Viewer control to select it and right mouse click on 
the control to view the context menu.  

4. To select a DWF file to embed, from the context menu, select “Autodesk DWF 
Viewer Control Object > Properties.” The control properties dialog appears.  

5. Click the “Browse” button to select a file locally or type in a URL to the DWF file 
in the “Path to the file you wish to view” field.  

6. Once you’ve selected the DWF file to embed, you can also choose to embed a 
copy of the DWF within the Word document itself or you can leave the file as an 
external resource. To embed the DWF within the Word document itself, check 
the checkbox option “Do you want to embed a copy of this file in the parent 
document?”  

7. To run the Autodesk DWF Viewer control and view the DWF file within your 
document, you’ll need to select the "Design Mode” button from the “Control 
Toolbox” toolbar. This button switches between design and run modes. When in 
Design Mode, you can change the control’s settings for Autodesk DWF Viewer 
and edit the path to the DWF file. When in “Run” mode you can view the DWF file 
and run Autodesk DWF Viewer as an application within your Office applications 

How do I avoid problems with missing fonts and font embedding issues? 
Font embedding is supported by DWF 5 and higher and was refined in DWF 6. 
Assuming you use DWF 6 or higher, you shouldn’t have to worry about font embedding 
since the default settings work well. For fonts to be embedded, two things have to 
happen: the publisher has to request that fonts be embedded (often the default setting) 
and the application used to create the DWF must support embedding the fonts. 
Autodesk products which support DWF 6 embed all “non-standard” fonts by default. 
There are only about 12 fonts that are considered “standard” because they are present 
almost universally on any international version of Windows above Win95. These 
“standard” fonts are not embedded by default in order to keep the DWF file size down. 
 
If you want to be absolutely sure that anyone viewing your DWF documents will have 
the correct fonts, you can change the default setting in your publishing application 
(AutoCAD, Autodesk DWF Writer, etc.) to “Embed All Fonts” so that even the “standard” 
fonts will be embedded. 
 
Alternatively, if you care more about file size than font accuracy, or if you are sure that 
the receivers of your DWF will have the required fonts, then you can change the default 
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publishing options to “Embed No Fonts”. If a receiver of your DWF is missing a required 
font on their system, they will get a warning dialog and the Autodesk DWF Viewer will 
substitute the missing font with a default font. 
 
If you receive a DWF file and the Autodesk DWF Viewer gives you an error saying that 
certain fonts are missing, one of the following is likely true: 

o You are viewing an old DWF file that pre-dates the font embedding capability (it 
was added several years ago to DWF 5). 

o You are viewing a DWF file created by an old Autodesk application that didn’t 
support font embedding at that point in history. Just about every current 
Autodesk application supports font embedding. For all other applications, you 
can use the Autodesk DWF Writer which does support font embedding. 

o You are viewing a DWF file created by a non-Autodesk application which didn’t 
support font embedding at that point in history. Again, use the Autodesk DWF 
Writer and you’ll get font embedding that way. 

o You are viewing a DWF file where the author of the DWF told the application not 
to embed the fonts. This means the author may have over-ridden the default 
settings to prevent fonts from being embedded. Authors sometimes (though 
rarely) do this in order to minimize file size or because a particular font’s 
licensing/copyright terms do not legally allow for embedding to happen with that 
font. In this case you’ll need to contact the DWF author. 

Can I view a DWF file without the Autodesk DWF Viewer Toolbar? 
This is easy. You can use the following param tag to hide the Autodesk DWF Viewer 
toolbar on your web page: 

<param name= “ToolbarVisible" value="False"> 
 
To control this using a URL to open the DWF file, specify the following: 

http://filename.dwf?ToolbarVisible=False 
 
When the viewer is embedded in a VB6 application, use the ToolBarVisible property to 
turn off the Autodesk DWF Viewer toolbar in your application as follows: 

Viewer.ToolbarVisible = False 
 
The complete Autodesk DWF Viewer application programming interface (API) 
documentation is available at www.autodesk.com/dwfviewer-api. For details see the 
chapter titled “Using the API in a VB application.” 

Can I view a DWF file without the Autodesk DWF Viewer Right-Click Menu? 
Yes. You can use the following param tag to turn off the Autodesk DWF Viewer right-
click menu on your web page: 

 <param name="UserInterfaceEnabled" value="False"> 
 
To control this using a URL to open the DWF file, specify the following: 

 http://filename.dwf?UserInterfaceEnabled=False 
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When the viewer is embedded in a VB6 application, use the UserInterfaceEnabled 
property as follows: 

Viewer.UserInterfaceEnabled = False 
 
The complete Autodesk DWF Viewer API documentation is available at 
www.autodesk.com/dwfviewer-api. For details see the chapter titled “Using the API in a 
VB Application.”  

Can I view a DWF file without the Autodesk DWF Viewer Hyperlink 
Tooltips? 
In the Autodesk DWF Viewer, you can turn off hyperlink tooltips as follows: 

1. Choose Tools>Options.  
2. In the Hyperlinks section, uncheck the Show Tooltips check box. 

 
To provide this capability for users who may view your DWF files without forcing them to 
adjust their tools options themselves, you van use the following param tag to do this 
programmatically on your website: 

<param name="HyperlinkTooltipVisible" value="False"> 
 
Similarly, if you want to control this option via a URL to open a DWF file, specify the 
following: 

http://filename.dwf?HyperlinkTooltipVisible=False 

DWF Programming 

As a developer/programmer, can I create or view DWF files from my 
application? 
The DWF format is an open format. Autodesk publishes a toolkit for reading and writing 
the DWF format. The DWF 6 Toolkit enables you to develop applications that read or 
write multisheet DWF drawings. The toolkit supports the DWF format as defined with 
the release of AutoCAD 2004. For more information, visit the Developer Center. For 
developers who simply want to display DWF files in a web page or application, the 
Autodesk DWF Viewer API (application programming interface) enables embedding of 
DWF drawings in HTML pages in Microsoft® Internet Explorer. To learn more about 
these capabilities visit the Tips section. 

Can I use scripts with the viewer to find areas in my DWF easier? 
You can define "named views" in your publishing application (AutoCAD, Revit, etc.) and 
these views will be written into the DWF file. You can see and select these views in the 
free Autodesk DWF Viewer (ADV) if you right click and select "Views...". 
 
Now that you have the views in the DWF, you can programmatically select one of those 
views. ADV doesn't have the LISP scripting language (that would make the viewer too 
big to download), but ADV has other scripting API's that you can use. ADV is really just 
an ActiveX control, so the API's can be called from JavaScript in a web page, VBscript 
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in a web page, or using any COM compatible language such as Visual Basic, C++, .Net 
C#, etc. 
 
I've attached an example ZIP file that has a DWF containing many named views and an 
HTML file that has VBscript inside it for controlling the viewer programmatically and 
animating to a particular AutoCAD named view. Look at the HTML code to see how this 
works. 
 
Finally, beyond using script or COM API's you can also specify a named view with just 
an URL to the DWF. For example if you have a hyperlink in a web page such as: 
  

<A href="http://www.foo.com/Test.dwf>Click Here to View the DWF</A> 
  
You could change it to something like: 
 

<A href="http://www.foo.com/Test.dwf?View=Kitchen>Click Here!</A> 
 
Clicking on the text “Click Here!” will load the DWF “Test.dwf” and then take you to the 
named view called “Kitchen” after the drawing loads. Note that many of the things you 
can do through the COM API can also be done via parameters on an URL as in this 
example. Since DWF “Bookmarks” include an URL, Bookmarks can also end up calling 
DWF APIs. 

Can I customize Autodesk DWF Viewer? 
Autodesk offers the Autodesk DWF Viewer API to customize, automate, and extend 
Autodesk DWF Viewer to meet your needs. The latest release includes enhanced APIs 
for controlling the visibility of layers in the DWF file. It also provides camera APIs for 
controlling the 3D view. Learn more at Autodesk Developer Center. 

Is there a 3D API for the Autodesk DWF Viewer? 
Not yet. In a future release, the API for 2D and 3D will be made more consistent. Until 
that time, we will not publicly document the existing 3D API. This will avoid the situation 
where our customers program to today’s 3D API – only to have to redo all of their work 
for the release where 3D and 2D are made consistent. 

What can the DWF toolkit be used for? 
The DWF™ 6.0 Toolkit allows you to develop applications that read or write multi-sheet 
drawings in DWF™ (Design Web Format™) format. The toolkit contains a C++ library 
that aids in the generation, reading, and parsing of DWF files. Experienced C++ 
programmers can use it to work with DWF files without having to understand their 
complete underlying data format. This toolkit contains support for the DWF file as 
defined with the release of AutoCAD 2004. The DWF Toolkit is not intended for Visual 
Basic programmers who wish to work with the API of the Autodesk DWF Viewer. These 
users should consult the Autodesk DWF Viewer API documentation. 
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Why am I getting a compilation error when compiling the toolkit for the first 
time? 
Pardon our oversight. The blockref.cpp file contained a few unwanted commas. You can 
download an updated copy of this C++ source file. 

Additional Help 
I would like to know more. Where should I start? 

1) I would first look at the on-line HELP documentation in the free Autodesk DWF 
Viewer product itself. It talks embedding the viewer in PowerPoint, in your own 
application, in a Web Page, etc. It also shows some example script code and 
such. 

2) The next level is to look at the ADV API documentation available in the developer 
section of www.autodesk.com/dwf. 

3) The next level is to read the DWF and ADV newsgroups on 
http://discussion.autodesk.com. 

4) The next level is to look at the DWF Toolkit (for advanced developers and C++ 
programmers) at http://www.autodesk.com/dwftoolkit. 

5) The next level is to join the Autodesk Developer Network (ADN) where you can 
get direct technical support and even professional services to help build 
applications. 

6) At the Autodesk University (Orlando, December 2005) conference we teach DWF 
courses and have many of the DWF team on site all week. Arrange a meeting to 
discuss your DWF needs and register for a class. 

I am having a problem that isn’t listed in this FAQ. How can I get more 
help? 

1) The DWF web site: http://www.autodesk.com/dwf 
2) The DWF discussion group: http://discussion.autodesk.com 
3) The Autodesk DWF Viewer discussion group: http://discussion.autodesk.com 
4) When using the discussion groups, it is possible to send a problem report to the 

DWF team: Please include the following information: 
o A detailed description of your issue 
o A description of which DWF viewer you are using, including the version 

and build numbers, if appropriate. 
o A copy of your DWF file, if appropriate 
o A copy of your native file (DWG, etc.) if available 
o Instructions on how to recreate the issue 
o Describe your operating system 
o Describe your printer model and printer driver version, if appropriate.  

 
Autodesk, AutoCAD, DWF, DWF Viewer, and DWF Composer, are trademarks or registered trademarks of Autodesk, Inc., in the USA and/or other countries. All other brand 
names, product names, or trademarks belong to their respective holders.  

Autodesk reserves the right to alter product offerings and specifications at any time without notice, and is not responsible for typographical or graphical errors that may appear in 
this document.  
© 2005 Autodesk, Inc. All rights reserved.  
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